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1.How many worksheets are present in a workbook (2016) in MS Excel? 

a. 1 

b. 2 

c. 3 

d. 4 

Ans: a. 1 

Explanation: The update from Excel 16 onwards, a new excel workbook contains only 

one sheet  

 

2.Which of the following is used to move an active cell to the first column on the 

current row? 

a. Pageup 

b. Ctrl+Home 

c. Page down 

d. Home 

Ans : b.Ctrl + Home 

Explanation: Ctrl + Home is used to Move an active cell to the first column on the 

current row. 

 

3. How do you change the width of a column in Excel?  

a. Drag the column boundary 

b. Use the “Format Painter” 

c. Apply a cell module 

d. Right -click and select “Column Width” 

Ans :  a. Drag the column boundary 

Explanation: change the width of a column in Excel by dragging the column boundary. 
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4. How do you insert a new worksheet in Excel? 

a. Right-click on a sheet tab and choose “Insert” 

b. Go to the “Home” tab and click “Insert Sheet” 

c. Press Ctrl + N 

d. Both A and B 

Ans :  d. Both A and B 

Explanation: You can insert a new worksheet by either right-clicking on a sheet tab 

and choosing “Insert” or going to the “Home” tab and clicking “Insert Sheet.” 

 

5. What is the keyboard shortcut for copying cells in Excel? 

a. Ctrl + X 

b. Ctrl + C 

c. Ctrl + V 

d. Ctrl + Z 

Ans :  b. Ctrl + C 

Explanation: Ctrl + C is used to copy selected cells in Excel. 

 

6. What does the term “cell” refer to in Microsoft Excel? 

a. A group of worksheets 

b. The intersection of a row and column 

c. A type of chart 

d. A formatting option 

Ans : b . The intersection of a row and column 

Explanation: a cell is the basic unit where data is stored, and it is identified by the 

intersection of a row and column. 
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7. _________________are vertical. 

a. Rows 

b. Columns 

c. Cell 

d. Workbook 

Ans: b. Columns 

Explanation: When you work with a spreadsheet, columns run vertically from top to 

bottom, allowing you to organize and manipulate data in a structured manner. Each 

column is identified by a letter label, such as A, B, C, and so on, and contains data or 

formulas within individual cells. 

 

8. How do you remove duplicate values in a column in Excel? 

a. Use the “Remove Duplicates” feature 

b. Apply a filter 

c. Sort the column in ascending order 

d. Manually delete duplicates 

Ans : a. Use the “Remove Duplicates” feature 

Explanation: You can remove duplicate values in a column by using the “Remove 

Duplicates” feature in Excel. 
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9. How can you merge cells in Excel? 

a. Use the “Merge & Center” button 

b. Apply a cell style 

c. Use the “Merge Cells” option in the Format menu 

d. Both A and C 

Ans :  d. Both A and C 

Explanation: You can merge cells in Excel by either using the “Merge & Center” button 

or the “Merge Cells” option in the Format menu. 

 

10. Cell Reference:A10,A20Refer to values in 

a. The cell in column A and row 10 

b. Cell A10 and cell A20 

c. The range of cells in column A and rows 10 through 20 

d. The range of cells in row 15 and columns B through E 

Ans: b. Cell A10 and cell A20 

Explanation: The correct answer is "cell A10 and cell A20." This is because the cell 

reference "A10" refers to the specific cell in column A and row 10, and the cell 

reference "A20" refers to the specific cell in column A and row 20. Therefore, the 

answer is that the cell reference refers to both cell A10 and cell A20. 
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11. What key is used to select multiple ranges of cells? 

a. Shift 

b. CTRL 

c. Alt 

d. AltGr 

Ans : b. CTRL 

Explanation: A function is defined with the keyword ‘def’ keyword followed by the 

function name, a pair of parentheses (), and a colon :. Parameters are optional.  

 

12. What is a 'Workbook' in Excel? 

a. A single worksheet 

b. A collection of charts 

c. A template file 

d. An Excel file containing one or more worksheets 

Ans : d. An Excel file containing one or more worksheets 

Explanation: a workbook is a file that contains one or more worksheets (also known 

as spreadsheets) to help organize data. 

 

13. What is the keyboard shortcut to save a workbook in Excel? 

a. Ctrl + S 

b. Ctrl + N 

c. Ctrl + P 

d. Ctrl + O 

Ans : a.Ctrl + S 

Explanation: Ctrl + S is the universal keyboard shortcut for saving a file, including in 

Excel. 
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14. What is a 'range' in Excel? 

a. A set of rows and columns 

b. A single cell 

c. A collection of contiguous cells 

d. The maximum value in a set of data 

Ans: c. A collection of contiguous cells. 

Explanation: In Excel, a range is a collection or block of contiguous cells that you can 

select, manipulate, or format together. 

 

15. How can you protect a worksheet in Excel? 

a. By setting a password 

b. By hiding the worksheet 

c. By converting it to a PDF 

d. By deleting unnecessary data 

Ans : a. By setting a password 

Explanation: To protect a worksheet in Excel, you can set a password that prevents 

other users from making changes to the worksheet's structure or its contents. 

 

16.  What does the 'Merge & Center' feature do in Excel?; 

a. Combines multiple cells into one and centers the content 

b. Merges data from different sheets 

c. Centers text in the selected cells 

d. Merges duplicate data 

Ans : a. Combines multiple cells into one and centers the content 

Explanation: The 'Merge & Center' feature in Excel allows you to combine multiple 

adjacent cells into a single larger cell and center the content within the merged cell. 
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17. What is the keyboard shortcut to open a new Excel workbook? 

a. Ctrl + N 

b. Ctrl + O 

c. Ctrl + S 

d. Ctrl + W 

Ans: a.Ctrl + N 

Explanation: Ctrl + N is the universal keyboard shortcut for opening a new document 

or file, including a new Excel workbook. 

 

18. How can you hide a column in Excel? 

a. By deleting the column 

b. By changing the font color to white 

c. By right-clicking the column header and selecting 'Hide' 

d. By setting the column width to zero 

Ans:  c. By right-clicking the column header and selecting 'Hide' 

Explanation: To hide a column in Excel, you can right-click on the column header and 

select 'Hide' from the context menu. This will make the column invisible, but it can be 

unhidden later if needed. 
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19. What is the maximum number of rows in Excel 2016 and later versions? 

a. 65,536 

b. 1,048,576 

c. 100,000 

d. 500,000 

Ans : b.1,048,576 

Explanation: In Excel 2016 and later versions, the maximum number of rows in a 

worksheet is 1,048,576. 

 

20. What is a 'Header Row' in Excel? 

a. The first row of a worksheet 

b. The top row of a table that contains column titles 

c. A row that repeats on every printed page 

d. The row at the bottom of the spreadsheet 

Ans: b. The top row of a table that contains column titles 

Explanation: In Excel, a 'Header Row' is the top row of a table or range that contains 

the column titles or labels. It is used to identify the type of data each column 

represents. 
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21. What is 'Flash Fill' in Excel? 

a. A tool to fill cells with a flash color 

b. A feature that automatically fills in data based on a pattern 

c. A method to quickly delete cell contents 

d. A function to highlight cells 

Ans: b. A feature that automatically fills in data based on a pattern 

Explanation: Flash Fill in Excel automatically fills your data when it senses a pattern. 

For example, if you are entering a list of dates or a series of numbers, Excel will fill in 

the remaining cells for you. 

 

22. What is a 'Named Range' in Excel? 

a. A range of cells with a specific name 

b. A function name 

c. A title for a chart 

d. A name given to a formula 

Ans: a. A range of cells with a specific name 

Explanation: A 'Named Range' in Excel refers to a range of cells that has been given a 

descriptive name, making it easier to identify or refer to those cells in formulas and 

functions. 
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23. What is the keyboard shortcut to insert a new worksheet in Excel? 

a. Ctrl + N 

b. Ctrl + T 

c. Shift + F11 

d. Alt + N 

Ans: c. Shift + F11 

Explanation: The keyboard shortcut to insert a new worksheet in Excel is Shift + F11. 

This adds a new worksheet to your workbook. 

 

24. What is the intersection of a column and a row on a worksheet called ? 

a. Column 

b. Value 

c. Address 

d. Cell 

Ans: D.Cell 

Explanation: Each cell is identified by a unique combination of its column and row 

 

25. In Excel, Columns are labelled as ___ 

a. A,B,C etc 

b. 1,2,3 etc 

c. A1,A2,A3 etc 

d. X,Y,Z 

Ans: a. A,B,C etc 

Explanation: In Excel, columns are indeed labeled with letters, starting from A and 

going sequentially through the alphabet: A, B, C, and so on. This labeling convention 

allows users to easily reference and identify specific columns within a worksheet. 
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26. The ____ feature of MS Excel quickly completes a series of data 

a. Auto complete 

b. Auto fill 

c. Fill Handle 

d. Sorting 

Ans: b. Auto fill 

Explanation: The loop inside the function runs three times and ‘z’ is printed each time. 

 

27. In Excel, Rows are labelled as ______ 

a. A,B,C etc 

b. 1,2,3 etc 

c. A1,A2,A3 etc 

d. X,Y,Z 

Ans: b. 1,2,3 etc 

Explanation: In Excel, rows are labeled with numbers, starting from 1 and going 

sequentially upwards: 1, 2, 3, and so on. This labeling convention allows users to 

easily reference and identify specific rows within a worksheet. 

 

28. ________consists of a grid made from columns and row. 

a. Cells 

b. Lables 

c. Spread sheets 

d. Fomula 

Ans: c. Spread sheets 

Explanation: A Spreadsheet consists of a grid made from columns and rows.It is a 

digital tools used for organizing and analysing data. 
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29. Lables are aligned at the ____________edge of the cell. 

a. Left 

b. Right 

c. Top 

d. Bottom 

Ans: a.Left 

Explanation: Lables are aligned at the left edge of the cell.this means that the text of 

the lables aill be positioned towards the left side of the cell. 

 

30.You can complete a cell entry by pressing_________. 

a. Enter 

b. Tab 

c. Shift + tab 

d. An Arrow key 

Ans: a. Enter 

Explanation: Pressing enter completes a cell entry in Microsoft Excel. This keyboard 

shortcut allows the user to stay in the current cell after entering data, rather than 

moving to the nest cell. 
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31._____________is the default font keyed in a new workbook? 

a. 12 pt. Times New Roman 

b. 11 pt. Calibri 

c. 12 pt. Bradley Hand ITC 

d. 10 pt. Times New Roman. 

Ans: B.11 pt. Calibri 

Explanation: The default font keyed in a new workbook is 11 pt. Calibri. 

 

 32.If you choose a larger font size, the height of the row is automatically made taller. 

a. True 

b. False 

c. Default Size 

d. One pt. will be increased. 

Ans: a.True 

Explanation: When a larger font size is chosen, the height of the row is automatically 

adjusted to accommodate the larger text. 

 

33.Which button allows you to copy cell formats one cell to another? 

a. Enter 

b. Autofit 

c. Format painter 

d. One pt. will be increased. 

Ans: c. Format painter 

Explanation: When you select the Format Painter button, which typically looks like a 

paintbrush icon, you can then click on the cell or range of cells whose formatting you 

want to copy. After selecting the source cell(s), click on the destination cell(s) where 

you want to apply the same formatting.   
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34.A______________ is a group of cells that from a rectangle on the screen. 

a. Label 

b. Workbook 

c. Column 

d. Range 

Ans: d.Range 

Explanation: A Range is a group of cells that form a rectangle on the screen. It can 

include a single cell, and is used to perform calculations, apply formatting or 

manipulate data within the specified cells. 

 

35.An example of a range address___________. 

a. A1:C2 

b. A1;B3 

c. A1-B3 

d. A1=b3 

Ans: a.A1:C2 

Explanation: A range address is a way to specify a group of cells in a spreadsheet.In 

this case ,the range address A1:C2 represents a rectangular area that includes cells 

A,A2,B1,B2,C1,and C2. 
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36._______, ________ and _______ are what you see when you open Excel 

a. Columns, rows, and charts 

b. Columns, rows, and formulas 

c. Columns, rows, and cells 

d. Cells 

Ans: c. Columns, rows, and cells 

Explanation: When you open Excel, you will see columns, rows, and cells. Columns 

are the vertical sections labeled with letters, rows are the horizontal sections labeled 

with numbers, and cells are the individual rectangular boxes formed by the 

intersection of columns and rows. These elements are the basic building blocks of 

an Excel spreadsheet and allow you to organize and input data in a structured 

manner. 

 

37. Ribbon is MS Excel is? 

a. Commands organized in small related groups is called Ribbon 

b. The band at the top of the Excel 2007 window is the Ribbon 

c. Menu 

d. All of the above 

Ans: b. The band at the top of the Excel 2007 window is the Ribbon 

Explanation: "The band at the top of the Excel 2007 window is the Ribbon." This 

statement accurately describes the Ribbon in MS Excel as the band located at the top 

of the Excel 2007 window. It is where commands are organized in small related 

groups, allowing users to easily access and navigate through different features and 

functionalities in Excel. 
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38 An example of a range address___________. 

a. A1:C2 

b. A1;B3 

c. A1-B3 

d. A1=b3 

Ans: a.A1:C2 

Explanation: A range address is a way to specify a group of cells in a spreadsheet.In 

this case ,the range address A1:C2 represents a rectangular area that includes cells 

A,A2,B1,B2,C1,and C2. 

 

39. In a new worksheet, you must start by typing in cell A1. 

a. True 

b. False 

c. Depends on 

d. Sometimes 

Ans: B.False 

Explanation: In a new worksheet, you are not required to start by typing in cell A1. You 

can start typing in any cell of your choice. 
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40. We can enter two basic kinds of data into worksheet cells: 

a. Numbers and text 

b. Numbers and figures 

c. Text and charts 

d. Text only 

Ans: a.Numbers and text 

Explanation: In a worksheet, you can enter two basic kinds of data: numbers and text. 

Numbers can be used for calculations and mathematical operations, while text can 

be used for labels, descriptions, or any non-numeric information. This allows for a 

versatile and comprehensive representation of data in the worksheet. 

 

41. You learned in the practice that ###### means: 

a. You've entered a number wrong 

b. You've misspelled something 

c. The cell is not wide enough 

d. The cell is merged  

Ans: c. The cell is not wide enough 

Explanation: In a worksheet, when entering data into a cell in a spreadsheet or table, 

the width of the cell is not sufficient to display the entire content. This can result in 

the data being cut off or displayed in a way that is not fully visible. To fix this issue, 

the cell width needs to be adjusted to accommodate the content.be used for labels, 

descriptions, or any non-numeric information. This allows for a versatile and 

comprehensive representation of data in the worksheet. 

  



 
Name of the Bundle Office Productivity  Bundle V2 (2024) Subject MS Excel 

Topic Introduction to Excel Last updated on 06 April 2024 

 

IT Support and Development Training Programme  
Creating Employable Engineers and Entrepreneurs  

 

42. What do you type into an empty cell to start a formula? 

a. An equal sign (=)  

b. A plus sign (+)  

c. Number  

d. Fx 

Ans: a. An equal sign (=) 

Explanation: To start a formula in an empty cell, you need to type an equal sign (=). 

This is because the equal sign is used to indicate that the cell will contain a formula 

and not just a regular value. By typing the equal sign, you are telling the spreadsheet 

software that you want to perform a calculation or use a function in that cell. 

 

43. A formula result is in cell C6. To see the formula, you: 

a. Click in cell C6, and then press CTRL+SHIFT 

b. Click in cell C6, and then press CTRL+SHIFT 

c. Click in cell C6 

d. CTRL+SHIFT 

Ans: c. Click in cell C6 

Explanation: Clicking in cell C6 allows you to select the cell and view its contents, 

including any formula that may be present. This will allow you to see the formula that 

was used to calculate the result in cell C6. 
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44. Cell Reference:A10,A20Refer to values in 

a. The cell in column A and row 10 

b. Cell A10 and cell A20 

c. The range of cells in column A and rows 10 through 20 

d. The range of cells in row 15 and columns B through E 

Ans: b. Cell A10 and cell A20 

Explanation: The correct answer is "cell A10 and cell A20." This is because the cell 

reference "A10" refers to the specific cell in column A and row 10, and the cell 

reference "A20" refers to the specific cell in column A and row 20. Therefore, the 

answer is that the cell reference refers to both cell A10 and cell A20. 

 

45.When you start a select a range of cells ,you will see a thick white,cross – shped 

pointer called a ______________. 

a. Cell selector 

b. Cell cross 

c. Selection pointer 

d. Range selector 

Ans: c. Selection pointer 

Explanation: When you start to select a range of cells, you will see a thick white ,cross 

shaped pointer called a selection pointer. This pointer allow you to indicate the 

specific range of cell that you want to work with in a spreadsheet or other software 

program. 

 

 


